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Introduction 

Qualtrics offers a powerful web based application that allows you to create surveys 
and collect responses.   

This course seeks to offer an introduction to the Qualtrics application and 
demonstrate how to create a basic survey 

Within this course we will design a survey, publish and distribute it.  We will then 
look at what we can do with the data gene rated by survey respondents. 

Objectives 

On successful completion of this course participants will be able to: 

• Create a survey using Qualtrics 

• Add question blocks and modify their properties 

• Add questions of varying types and modify their properties 

• Add questions from Qualtrics library of questions 

• Save Versions of a Qualtrics survey 

• Preview and Test a Survey 

• Add branching to a survey based on a respondents answer 

• Alter the appearance of a survey to include Logos, background images and 
customised colours 

• Publish a survey 

• Distribute a survey 

• Export data from a survey 

• Create a visual report  
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Introduction to Qualtrics 

1 Introduction to Qualtrics 

Welcome to our course on Qualtrics, a powerful tool for creating and analysing 
surveys. In this course, you will learn how to set up a Qualtrics account, create and 
design surveys, distribute them to collect responses, and analyse the results. We 
will also cover some advanced features and best practices for using Qualtrics. 

a. What is Qualtrics and why is it used? 

First, let's start by introducing Qualtrics and why it is used. Qualtrics is a survey 
software that allows you to create and conduct surveys online. It is widely used in 
academia, market research, and other fields to collect and analyse data from 
participants. With Qualtrics, you can create surveys using a variety of question 
types, customize the look and feel of your survey, and view and analyse the results 
in real-time. 

b. Setting up a Qualtrics account and navigating the interface 

To get started with Qualtrics, you will need to log in with your university account.  
To log in visit https://uofg.qualtrics.com/ and log in using your GUID and account 
password 

Once you have logged in you will be resented with the following screen 
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The main menu on the left side of the screen allows you to access different parts of 
the platform, such as the survey editor, results, and settings.  There will be a list of 
projects here once you have created them 

2 Creating a Survey 

First step in creating a survey is to plan and design it. Think about the purpose of 
your survey, who your target audience is, and what information you want to gather. 
Next, you can start adding questions to your survey. Qualtrics provides a wide 
range of question types, including multiple choice, open-ended, and rating scales. 
You can also add images, videos, and other media to your survey. Once you have 
added all of your questions, you can format the survey to match your branding or 
style. 

a. Create a project in Qualtrics 

1 Log in to your Qualtrics account. 
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2 From the menu on the top left of the interface click Projects 
 

 

3 Click the "Create Project" button. 
 

  
 
The interface will change to the Create a project page 
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4 Look through the Create a project page.  Notice that if you scroll to the 
bottom of the page you will find Academic project templates 
 

 

5 Click Survey from the From Scratch section at the top of the interface: 
 

 

6 From the pane that appears on the right of the interface click Get Started 
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7 From the Create a new project screen that appears fill in the name of your 
project.  For this exercise we will call our survey Training Evaluation  

8 From the How do you want to start your survey? combo box control select 
Create a blank survey project 
 

 
 
There will be a pause for a few seconds while Qualtrics generates your new 
survey 

9 You can now start building your survey, questionnaire or form in the Qualtrics 
platform. 

b. Planning and designing a survey 

Designing a Qualtrics survey involves several steps, including planning, creating 
questions, and formatting the survey. Here are some guidelines to help you design 
a successful survey: 

• Define the purpose of your survey: Before you start creating your survey, 
think about what you want to accomplish. Are you trying to gather feedback, 
measure customer satisfaction, or research a particular topic? Clearly 
defining the purpose of your survey will help you create relevant questions 
and focus on the information you need to collect. 

• Determine your target audience: Consider who you are trying to reach with 
your survey. Are you targeting a specific age group, geographic location, or 
industry? Understanding your target audience will help you create questions 
that are relevant and easily understood. 

• Choose the right question types: Qualtrics offers a variety of question types to 
choose from, including multiple choice, open-ended, and rating scales. Select 
the types of questions that best fit the information you are trying to gather. 
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Avoid using too many open-ended questions, as they can be time-consuming 
to answer and difficult to analyze. 

• Keep the survey short and focused: Surveys that are too long or try to cover 
too many topics can be overwhelming for respondents and may result in 
lower response rates. Try to keep your survey as short and focused as 
possible, and only include questions that are necessary to achieve your 
goals. 

• Use clear and concise language: Use simple, straightforward language in 
your survey to ensure that all respondents can understand the questions. 
Avoid using jargon or technical terms that may be unfamiliar to some people. 

• Test and refine your survey: Before you send your survey out to a large group 
of respondents, test it with a small group of people to see if it is clear and 
easy to understand. Use their feedback to make any necessary adjustments 
before distributing the survey to a wider audience. 

3 Adding questions and formatting the survey 

a. The Survey Tab 

The survey tab provides you the tools to help you build a survey, There are 4 main 
elements to the interface.   

 

1 Survey toolbar 

2 Question block 

3 Question editing area 
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4 Question editing pane 

b. Working with Blocks 

Every survey includes at least one block initially called the Default Question Block., 
Every questions you create or edit will be stored inside blocks. 

By separating questions into blocks, Qualtrics allows you to control how the 
questions are asked, so for instance you can have blocks of questions collapse to 
make the page clearer, you can randomise the blocks or even have certain blocks 
display in response to specific answers give before.   

Blocks are best understood with a couple of examples: 

For the most basic surveys, placing all of your questions in a single block will work 
well,  But as surveys become more complex, placing questions into multiple blocks 
allows the you to create of a sophisticated survey flow, including branches, 
randomization, authentication, and embedded data. 

c. Adding Questions 

There are several ways to add questions to your Qualtrics survey, You can add 
your own questions, created from scratch as well as asking questions using pre-
built templates supplied by Qualtrics. 

 

 

Adds questions 
of the same type 

Adds questions 
using templates

Adds questions 
from list of types  
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 Create a question using a template 

To add questions to a Qualtrics survey, follow these steps, with the Training 
Evaluation survey that you have just created: 

1. Click the Import from library button in the top menu. 

2. From the Question library dialogue that appears select Demographics 

3. From the Demographics menu select Calendar & Date Questions 
 
Note: You can select from either the menu item or the block.  It makes no 
difference.   

4. Select the first entry from the block of three different date questions 
 

 
 
You will see an example of javascript that is the code that makes this date 
picker work in a web browser.   

5. Click the Insert Question button at the bottom of the pane 

6. The question will appear, though what you are seeing is not how the 
question will look in the completed survey  

7. Click on the text Enter a date: within the newly created question 

8. Without changing the question text go to the HTML view of the question.  
 

 
 

9. Change only the first line of the text with the required without disturbing the 
code. 
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10. Edit the text to read What date did you attend the course? 

 

 Adding a question from the list of types 

1. Click on the + Add new question button 

2. From the list of question types, select Multiple choice 
 
A multiple choice question will appear 

3. Click the question Click to write the question text 

4. Type What category of student are you? 

5. Click the 1st answer 

6. Type Undergraduate 

7. Click the 2nd answer 

8. Type Postgraduate 

9. Click the 3rd answer 

10. Type Other 

11. Click the arrow to the left of the 3rd question text: 
 

 

12. From the menu that  
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13. Enter the question text and any additional options or settings for the 
question. For example, you can add answer choices for multiple choice 
questions or specify the scale range for rating questions. 

14. Click the "Save" button to add the question to your survey. 

15. Repeat the process to add additional questions to your survey. 

16. When you have finished adding questions, you can preview and test your 
survey to make sure everything is working correctly. 

Note: You can also add images, videos, and other media to your survey by using 
the "Insert" menu in the top menu. 

d. The Tools Menu 

The tools menu offers you access to useful tools for your survey,  

 

Some notable tools: 

Auto-Number Questions Question numbers are the numbers to the left of each 
question. By default, they’re preceded by a “Q,” and in their unmodified state, they 
act as a question creation counter (e.g., “Q15” represents the 15th question you 
have created for the survey). 

By default, question numbers are not seen by respondents; instead, they are used 
to identify your questions when you are reviewing your downloaded data or 
referencing questions within the Qualtrics platform. 

Reset Recode Values When you create a question, a Recode Value and a 
Variable Name are automatically assigned to each answer choice. The recode 
value is the numeric value of a choice, whereas the variable name is the label of 
the choice when you export in choice text format. By default, the first answer 
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choice will have a recode value of 1, the second choice 2, and so forth, even if you 
remove answer choices or change the answer choice order. 

Sometimes you’ll want to reset all of your recode values. Maybe you copied your 
survey from an old one and don’t want the same recodes, or maybe you made 
many edits you don’t like and want to start over. 

Generate test responses If you want to see how your dataset or reports will look 
before sending out your survey, but you don’t want to complete the survey yourself 
over and over, you can generate random dummy data.  

Versions You can save a version of your survey and revert back to that version at 
a later date.  Aside from publishing or saving your survey normally, you can 
choose to create a new survey version any time. 

1 Navigate to the Survey tab and 
click Tools. 

 

2 Highlight Versions. 

3 Select Create New Version. 

4 Add a description. This can be whatever you like. Dates will automatically be 
stored with the version, so don’t worry about adding date labels. 

https://www.qualtrics.com/m/assets/support/wp-content/uploads/2021/03/publish-7.png
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5 Click Create Version. 

6 If you want to revert to an older version click Tools 

7 From the Menu Pick Version > View version history 
 

 

8 From the version history select the version you want 

9 Click Restore this version 

4 Previewing and testing the survey 

After you have finished creating your survey, it's important to preview and test it to 
make sure everything is working properly. You can do this by clicking the "Preview" 

https://www.qualtrics.com/m/assets/support/wp-content/uploads/2021/03/publish-8.png
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button in the top menu. This will allow you to see what the survey looks like from 
the respondent's perspective and make any necessary adjustments. 

a. Using the Preview tool 

1 Click the Preview button on the top left side of the screen 
 

 
 
A new window will appear in your browser. 

2 Take some time to play with the questions in the form, this should be close to 
the same experience that your forms users will experience. 

b. Preview Banner 

This banner will have options useful for previewing the survey. Remember, these 
options are only available during the preview mode and will not be accessible with 
live links. 

The Restart Survey control allows you to restart the survey and navigates you to 
the beginning 

When you click on the Tools control, you will see a menu appear with four items 
on it: 

 

Ignore validation bypasses questions with answer validation, such as any 
character limits in Text Entry questions. This includes force response and custom 
validation. It also allows you to bypass non-SSO authenticators so that you can 
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complete the survey without authenticating. This is helpful when you want to test a 
specific portion of your survey without having to answer every required question. 

Show hidden questions lets you view questions that may be hidden to 
respondents, like timing and meta info questions. This option is enabled by default. 
Remember that this option only applies to the preview survey mode and that these 
questions will not be seen by respondents accessing a live link. 

Place Bookmark tags any page you are currently on, letting you skip previously 
tested questions later. Note that after placing the bookmark, the Place Bookmark 
button will be replaced with a button that says, “Go to Bookmark.” The next time 
you start your preview survey, you can click Go to Bookmark and jump ahead to 
the bookmarked page. 

At any point, you can clear away the bookmark or place it somewhere else. Click 
the “Clear” button to clear your current bookmark and place a new one. 

5 Distributing Surveys 

Now that your survey is ready, it's time to distribute it to collect responses. There 
are several ways you can do this, including sending the survey via email or link, or 
embedding it on a website. You can also set up reminders and incentives to 
encourage people to complete the survey. As responses come in, you can track 
completion and view the results in real-time. 

a. Sending the survey via email or link 

To send a survey you must first publish it.  You do this via the Distributions tab.  
When you click on this tab in an unpublished survey you will be offered the 
following screen.  Selecting any of these options will publish the survey. 
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As the Distributions tab first opens, you’ll need to pick a distribution channel. 
Channels include: 

• Email 

• Web 

• Social 

• Mobile 

• Online Panel 

If you select one of the channels, and underneath you will be presented with a variety 
of methods that are relevant to that channel.  Selecting a method will start collecting 
survey responses. 

b. Distribution Summary  

After you select your initial channel and method, Qualtrics will reveal a distribution 
summary so you can track your response metrics. 

 

The distribution summary will show you, in real time, the responses that have been 
collected. Responses are broken down by channel with an interactive graph and a 
table displaying your response trends. 

These metrics can help you spot troubles early and adjust quickly to keep your 
research on track. The summary can also help you decide if you have sufficient 
data to stop collecting data. 
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c. Stages of Response Collection 

To protect your project’s response data, a survey passes through stages: 

• New: You are still creating your survey. No data is being collected. 

• Active: You have selected your distribution channels and methods. 

• Paused: You have paused or halted survey collection because you: 

o Have completed your data collection. 

o Need to make corrections or add additional questions. 

If you are not careful, some changes may invalidate parts of your 
data. To identify the types of changes that may affect reliability and 
validity, visit the testing/editing active surveys page. 

• Resume: You have decided to resume response collection. 

• Expired & Closed: You have set a survey availability date and time. At that 
instant, survey collection ends and the survey is closed to any additional 
responses. Even after you’ve passed your availability date, you can: 

o Restart your data collection. You will need to remove 
the availability from before resuming data collection. 

o Recycle a survey by making a copy. 

o Delete all of the current responses and redistribute the survey again. 

6 Data & Analysis 

Once you have collected enough responses, you can start analysing the results. 
Qualtrics provides several options for viewing and exporting the raw data, including 
charts, tables, and pivot tables. You can also generate reports and export the data 
to other tools for further analysis. As you interpret the results, be sure to consider 
the limitations of your survey and the potential biases of your respondents. 

Most filtering, classifying, merging, importing, and data cleaning activities take 
place under the Data section. For example: 
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1 Display and review results in the responses window by toggling between 
your: 

 

a. “Completed” or Recorded Responses 

b. “Incomplete” or Responses in Progress 

2 Filter by specific questions or by your saved filters, survey metadata, contact 
fields, or embedded data fields. 

3 Navigate page-by-page through your responses. 

 

4 Click the Export & Import dropdown menu to import responses, combine 

responses from multiple surveys, manage your previous downloads, 
or export your data in various formats. 

5 Click into individual answers to edit responses; you can add answers to 
individual responses or make essential edits,  

https://www.qualtrics.com/m/assets/support/wp-content/uploads/2015/04/data-analysis-overview-1.png
https://www.qualtrics.com/m/assets/support/wp-content/uploads/2015/04/data-analysis-overview-2.png
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6 Translate responses, save column layouts, or set up projects as a 
supplemental data source under the Tools dropdown menu. 

7 Select the columns for your data table by clicking Column chooser. 

 

8 Delete, edit, or revert changes to multiple responses by using the checkboxes 
in the data table. 

9 Click any column header to move, hide, or sort columns (e.g., A-Z). You can 
also view responses as numeric values (also known as recode values) in a 
column. 

 

https://www.qualtrics.com/m/assets/support/wp-content/uploads/2015/04/data-analysis-overview-3.png
https://www.qualtrics.com/m/assets/support/wp-content/uploads/2015/04/data-analysis-overview-4.png
https://www.qualtrics.com/m/assets/support/wp-content/uploads/2015/04/data-analysis-overview-5.png


 

Introduction to Qualtrics (V1.0) 22 

10 Click the three horizontal dots to see more options, including deleting 
individual responses, exporting data to a PDF, or issuing a survey retake. 
 

 

b. Viewing and exporting raw data 

1 From the Data & Analysis tab, and with Data selected 

2 Select Export & Import 
 

 

3 Select Export Data 

https://www.qualtrics.com/m/assets/support/wp-content/uploads/2015/04/data-analysis-overview-6.png
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4 From the popout that appears, select the data format that you wish to export 
 

 

5 Select the options using the tick box/radio buttons 

6 Click More Options if you need to make further changes 

7 Click Download 

7 Advanced Features 

In addition to the basic features covered so far, Qualtrics also offers advanced 
options for those who want to customize their surveys even further. For example, 
you can use logic and branching to show different questions or sections based on 
the respondent's previous answers. You can also use custom scripts and 
integrations with other platforms to extend the functionality of your surveys. 

a. Adding logic and branching to surveys 

Branches are useful when you want to send respondents down different paths in 
the survey. You can use branch logic to branch respondents to different survey 

flow elements based on variables like question responses or embedded data. 
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 Adding a Branch 

1 While editing your survey, click the Survey flow icon in the left navigation 
bar. 
 

 

2 Click Add Below or Add a New Element Here. 
 

 

3 Choose Branch. 
 

 

4 Click Add a Condition and add a logic condition (conditions can be based on 
questions, Embedded Data, Device Type, Quotas, or GeoIP Location). 

https://www.qualtrics.com/m/assets/support/wp-content/uploads/2021/03/SurveyFlow1.png
https://www.qualtrics.com/support/wp-content/uploads/2015/04/image0137.png
https://www.qualtrics.com/support/wp-content/uploads/2015/04/image0524.png
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5 Create a new element or move an existing one underneath the branch. 

 
 
Participants who answer “Yes” to the question “Do you own an E-Book 
reader?” will be shown the E-Book Current Customers block. 

 

b. Display Logic 

You can use display logic to create a survey that is customized to each respondent. 

When a specific question or answer choice pertains only to certain respondents, you 

can set display logic on it so that it shows conditionally based on previous information. 

You can choose to conditionally display both questions and answer choices, allowing 

you to create a survey that dynamically adapts to your respondent’s answers. Display 

logic is found in the Question behaviour section of the survey builder. 

https://www.qualtrics.com/support/wp-content/uploads/2015/04/image0724.png
https://www.qualtrics.com/support/wp-content/uploads/2016/04/branch3.png
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 Setting Display Logic 

1 Select the question that you want to display conditionally. 
 

 

2 Select Display logic. 

3 Set the condition that must be met for the question to display. The condition 
can be based on any of the following: 
 

 

• Question: Display a question only if the respondent chose a specific answer 

to a previous question. This is the only option compatible with in page display 

logic (see below).  

• Embedded Data: Use any information you have stored about the respondent 

to set display conditions. For example, only display a question to those who 

have an embedded data field for Age, equal to 25.  

• Quota: Once a Quota has been created, set a condition based on whether or 

not the quota has been met.  

• Contact List: Base the condition on information already stored in a contact 

list field, such as first name, last name, or email.  

https://www.qualtrics.com/m/assets/support/wp-content/uploads/2021/02/QuestionDisplayLogic12.png
https://www.qualtrics.com/m/assets/support/wp-content/uploads/2021/02/QuestionDisplayLogic3.png
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• GeoIP Location: Automatically use the IP address of the survey participant to 

estimate their location and set a condition based on country, city, postal code, 

etc.  

• Loop & Merge: After a loop and merge block has been created, set the 

conditions within the loop and merge based on the current loop.  

• Device Type: Base the condition on what type of mobile device is or is not 

being used, including Mobile (any mobile 

device), Blackberry, Android, iPad, iPhone, iPod, Opera 

Mobile, Palm, Windows Mobile, and Other Mobile (any mobile device that 

is not listed here). 

• True – False: Create a condition that always evaluates to true (meaning the 

question will always display) or false (meaning the question will never 

display). This is particularly useful when building and testing your survey. 

See logic based on true – false. 

4 If desired, select the In Page checkbox if you want the question to appear 
immediately once the condition is met, rather than displaying it on the next 
page of the survey. For more information about this option, read the using in 

page display logic section. 
 

 

5 When finished creating your conditions, click Save. 

  

https://www.qualtrics.com/m/assets/support/wp-content/uploads/2021/02/QuestionDisplayLogic45.png
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Useful Shortcut keys 

Using keyboard shortcuts can help you become more efficient when creating documents 
in Microsoft applications.  Most keyboard shortcuts require you to use two or more keys 
at the same time.  To use a keyboard shortcut first press and hold down the modifier key 
or keys (i.e. SHIFT, CTRL, ALT) and then press the corresponding standard key on your 
keyboard.] 

Function Shortcut 

General   

Open this legend Ctrl+/ 

Move focus to next section Ctrl+F6 

Move focus to previous section Shift+Ctrl+F6 

Move focus to next related element Ctrl+Space 

Move focus to previous related element Shift+Ctrl+Space 

Question actions   

Add question above Ctrl+Alt+a 

Add question below Ctrl+Alt+b 

Enter question Enter 

Exit question Escape 

Focus rich content editor toolbar from question 
text 

Alt+F10 

Delete question Delete 

Question selection   

Select question below ↓ or → 

Select question above ↑ or ← 

Extend selection down Shift+↓ 

Extend selection up Shift+↑ 

Focus down without changing selection Ctrl+↓ 

Focus up without changing selection Ctrl+↑ 

Select or unselect question x 

Select all questions in block Ctrl+a 

Unselect all other questions Shift+n 
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Block actions   

Enter block Enter 

Exit block Escape 

Delete block Delete 

Block selection   

Select next block Tab 

Select previous block Shift+Tab 

Move questions or block   

Initiate move on selected items Space 

Move placement indicator ↑ or ↓ 

Place item(s) Space 

Cancel operation Escape 
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	3 Navigate page-by-page through your responses.
	4 Click the Export & Import dropdown menu to import responses, combine responses from multiple surveys, manage your previous downloads, or export your data in various formats.
	5 Click into individual answers to edit responses; you can add answers to individual responses or make essential edits,
	6 Translate responses, save column layouts, or set up projects as a supplemental data source under the Tools dropdown menu.
	7 Select the columns for your data table by clicking Column chooser.
	8 Delete, edit, or revert changes to multiple responses by using the checkboxes in the data table.
	9 Click any column header to move, hide, or sort columns (e.g., A-Z). You can also view responses as numeric values (also known as recode values) in a column.
	10 Click the three horizontal dots to see more options, including deleting individual responses, exporting data to a PDF, or issuing a survey retake.
	b. Viewing and exporting raw data
	1 From the Data & Analysis tab, and with Data selected
	2 Select Export & Import
	3 Select Export Data
	4 From the popout that appears, select the data format that you wish to export
	5 Select the options using the tick box/radio buttons
	6 Click More Options if you need to make further changes
	7 Click Download


	7 Advanced Features
	a. Adding logic and branching to surveys
	Adding a Branch
	1 While editing your survey, click the Survey flow icon in the left navigation bar.
	2 Click Add Below or Add a New Element Here.
	3 Choose Branch.
	4 Click Add a Condition and add a logic condition (conditions can be based on questions, Embedded Data, Device Type, Quotas, or GeoIP Location).
	5 Create a new element or move an existing one underneath the branch.   Participants who answer “Yes” to the question “Do you own an E-Book reader?” will be shown the E-Book Current Customers block.


	b. Display Logic
	Setting Display Logic
	1 Select the question that you want to display conditionally.
	2 Select Display logic.
	3 Set the condition that must be met for the question to display. The condition can be based on any of the following:
	4 If desired, select the In Page checkbox if you want the question to appear immediately once the condition is met, rather than displaying it on the next page of the survey. For more information about this option, read the using in page display logic ...
	5 When finished creating your conditions, click Save.
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